Bibliographic Management Using EndNote

A Handbook for Research Students

Mr. S Ketheeaswaren

Staff Development Center
University of Jaffna

2015

Available at:
http://repo.lib.jfn.ac.lk/ujrr/retrieve/1946
Preface

Staff Development Centre (SDC) of the University purchased Endnote software with collection of keys, in 2014. The CD of software is distributed to every department of the University and Vavuniya Campus, by the Director of the SDC. At the same time, I was found as a Resource Person on Endnote software to catch my course of reference management learnt during the Masters in Library and Information Science, and share the same with endusers of Endnote software in the University of Jaffna.

During session hours of the programmes for Reference Management using Endnote, conducted by the Staff Development Centre, the participants started requesting for a Handbook and being published in the Research Repository. Thus, the Director / SDC requested me to prepare a handbook for Reference Management using Endnote. I could prepare this handbook by provided guidance from Prof. P Ravirajan, the Director / SDC.

This is the handbook for Endnote reference management. Which can be used by researchers, authors, profile makers and as a tool for data management of bibliographic researches.

It still needs future editions and developments.

Ketheeswaren, S.

(+94777834603, vskethees@gmail.com)
Contents

1. Introduction .............................................................................................................................................. 5

   EndNote? .................................................................................................................................................. 5

   Opening endnote ....................................................................................................................................... 5

   Creating an EndNote Library and save it to the hard drive. ......................................................... 5

   The Library Window ............................................................................................................................... 5

       Panels .................................................................................................................................................. 5

       Navigating the Reference List ......................................................................................................... 6

   The Groups Panel .................................................................................................................................... 6

       Permanent groups: ............................................................................................................................ 6

       Temporary groups .............................................................................................................................. 6

       User Created groups: ......................................................................................................................... 6

1. Enter Reference Data Manually ........................................................................................................... 8

   The basic bibliographic fields of references - Based on Endnote ...................................................... 9

2. Import downloaded references & Export from databases ................................................................. 10

   Downloading (exporting) References ............................................................................................... 10

   Importing the downloaded reference file ............................................................................................ 12

3. Import and search PDF files produced by publishers ...................................................................... 13

   Search and download PDF files .......................................................................................................... 13

   Importing a PDF file into EndNote ...................................................................................................... 13

   Importing a PDF folder into EndNote .................................................................................................. 14

4. Search databases from Endnote ...................................................................................................... 14

   Online Search Mode ............................................................................................................................ 15

       Coping to Local Library .................................................................................................................... 16

5. Store or link to PDF/Word files with reference ................................................................................. 17

6. Print or save a list of references ........................................................................................................ 19

   Printing selected references ................................................................................................................ 19

       Selecting references for printing .................................................................................................... 19

       Printing ............................................................................................................................................... 20

       Saving (export) selected references ................................................................................................. 21

7. Insert citations into the word document ............................................................................................ 22
Inserting citations from word document itself ................................................................. 22
Inserting citations from EndNote ...................................................................................... 24
8. Generate bibliography in different style .......................................................................... 26
   Output style ....................................................................................................................... 26
   Layout ............................................................................................................................... 27
Appendix I : ....................................................................................................................... 29
Citation Download Methods from the Databases subscribed for University of Jaffna ........... 29
   1. Sage .............................................................................................................................. 29
   2. Emerald ......................................................................................................................... 30
   3. Wiley ............................................................................................................................ 31
   4. Oxford Journals ............................................................................................................ 32
   5. Chicago Journals ......................................................................................................... 33
   6. ARDI ............................................................................................................................. 34
   7. ASABE .......................................................................................................................... 37
   8. American Institute of Physics ....................................................................................... 38
1. Introduction

_EndNote_?
Tool - Managing bibliographic data; which can be searched, edited and integrated into a Word document by.

**Opening endnote**

To open Endnote program

(Start) > All Programs > EndNote > EndNote program

**Creating an EndNote Library and save it to the hard drive.**

- From EndNote’s File menu, choose New.
  
  ![New Reference Library](image)

  1. Click on **File**, then **New**
  2. Choose the correct location for saving
  3. Write a **filename** for the Library
  4. Click on **save**

- Enter a file name and a location for your new library to be saved. Click **Save**

- A new library will appear as an empty EndNote library, showing “0 out of 0 references.”

  ![EndNote Library](image)

**The Library Window**

**Panels**

When you first open a library, you will see three different panels:

- **My Library panel**: Displays subsets of references for your library such as groups, etc.
- **Reference list panel and Search Panel**: Displays individual references on a single line.
- **Preview/Edit panel**: Includes tabs to easily access common tasks like Preview of reference, view of attached pdf etc.
  Note: Click on the **Layout** icon at the bottom right of the window to change the layout.

**Navigating the Reference List**

There are a number of ways to browse through the references:

- We can quickly sort the references by clicking on a column heading. For example, click **Year** to sort by year.
- Typing a letter selects the first matching reference.
- The **HOME** and **END** keys go to the first or last reference respectively.

**The Groups Panel**

- Two types of groups: Permanent, Temporary.

**Permanent groups:**

- **All References**: Displays all of the references in the current library.
- **Unfiled**: Contains any references in your library that have not been allocated to a group.
- **Trash**: Contains the references you have removed from the library by highlighting references and selecting Move References to Trash. While the references are no longer in your library, they are not completely deleted until you go to the Groups menu and select Empty Trash.

**User Created Temporary groups:**

- **Copied References**: Using the copy and paste commands to transfer references.
- **Duplicate References**: Displays the results of duplicate detection in your library. You can run duplicate detection from the References menu and choosing Find Duplicates.
- **Imported References**: Displays the last set of references imported into the library with the File>Import command, or through direct export from a database.
- **Search Results**: Displays the most recent search results.
  Note: Temporary groups are deleted when a library is closed.

**User Created groups:**

- **Custom Groups**
  Custom Groups make it easy to break a large library into subsets for later viewing. A group points to a subset of references that already exist in the library. Custom Groups have a folder icon.

  - From the **Groups** menu choose **Create Group**. Give your group a name and press **Enter**. Alternatively, right-click on **My Groups** in the My Library pane and choose **Create Group**.
There are several ways to add records to a group; highlight the record(s) then use the drag & drop method to move the reference(s) to the appropriate group, or from the Group menu choose Add References To and select the relevant group.

**Smart Groups**

Smart Groups have an inbuilt search query and can dynamically update as you add and edit references in the library. Smart Groups have a light bulb icon.

From the Groups menu, select Create Smart Group. At the search dialog enter a name for the group, a search strategy, and select Create.
1. Enter Reference Data Manually

1. Select "Local Library Mode"

2. Select, to which group the reference must be added

3. Select "New Reference"

4. Select the Reference Type

5. Type the Data as appropriate & Save (Ctrl + S)
### The basic bibliographic fields of references - Based on Endnote

**Common Fields:**
Author, Title, Year of Publication (Copyright year), and Abstract

**Other Fields**

<table>
<thead>
<tr>
<th>Type of reference</th>
<th>Name of Source</th>
<th>Volume number</th>
<th>Number of volumes</th>
<th>Session number</th>
<th>Issue number</th>
<th>Pages</th>
<th>Start page</th>
<th>Type of document</th>
<th>DOI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Book</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Journal Article</td>
<td>Journal Name</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>☑</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Conference paper</td>
<td>Conference name</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
<td>☑</td>
</tr>
<tr>
<td>Conference Proceeding</td>
<td>Conference name</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Figure</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type of reference</th>
<th>ISSN</th>
<th>Location</th>
<th>Place</th>
<th>Caption</th>
<th>Source Program</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Book</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Journal Article</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Conference paper</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Conference Proceeding</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>Figure</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

✓ - Always available
✓ - May be available
✗ - Not available

Continued.....
2. Import downloaded references & Export from databases

Downloading (exporting) References

From Taylor and Francis

(Subscribed under UGC-Consortium: You may use library website for necessary link)

Go to “Advanced and citation search”

You will get a set of search result,

1. Check on Journal and Only content I have full access to

Because from Taylor and Francis, University has only Journal access

2. Click on Search
You will be brought to the following window,

**Download Citation**

1. **Check interested**

2. **Choose action Download Citation**

You will be brought to the following window,

**Download Citation**

1. **Choose RIS format**

2. **Select appropriate**

2. **Click on**

Locate the downloaded file and place it in a convenient place for necessary import to the endnote
Importing the downloaded reference file

Go to Endnote Local Library

1. Click on Icon for import

2. Find and Select downloaded file from the correct location

3. Choose the RIS as import Option

4. Click on

5. Select all reference (Ctrl+A) or Selectively each with Ctrl Key

6. Drag and Drop to the Group
3. Import and search PDF files produced by publishers

Search and download PDF files

Importing a PDF file into EndNote

Open the EndNote library into which you want to import the references.

You will get the following Window

Please note: documents must have been created as PDFs and contain a DOI for this feature to work. This data retrieval function will not work with scanned documents.
Importing a PDF folder into EndNote

Open the EndNote library into which you want to import the references.

1. From the File menu, choose Import, then Folder.

You will get the following window

- Locate the Folder Holding PDF files
- Check if there are PDF files as of subfolders
- Check if needed to create a Group Set of folder name

3. Choose PDF option

4. Search databases from Endnote

- Local Library Mode
- Integrated Library & Online Search Mode
- Online Search Mode (Temporary Library)

- Integrated Library & Online Search Mode - downloaded directly to the currently open library.
- **Online Search Mode** - downloaded to a temporary library, any references we wish to save must be copied to an existing library before switching back to Local Library Mode

- Pre-configured connection files - connecting to Z39.50 compliant databases

### Online Search Mode

1. Select **Online Search Mode**
2. Select **PubMed**
3. Write **Keyword**
4. Limit the **maximum number of records** for retrieving, say **20**
5. Click on

Then You will get into the window
Coping to Local Library

1. Select the needed reference for copying
2. Click on the Icon I for copying
3. Go to Local Library

The following window will appear

Select, Drag and Drop to a Group, Say Oncology
5. Store or link to PDF/Word files with reference

You will get the following window,

3. Find and Select a PDF file

4. **Relative Link**: when the above box “*Copy this file to the default file attachment folder and create a relative link*” is checked, a copy of the original file will be created and placed in the `.Data` folder of the corresponding EndNote library.

**Absolute Link**: when the box is un-checked, EndNote will create a full path and filename to the original file.

However, you should remember that the absolute links are static not dynamic. This means if you ever change the location of the file the link will not work and EndNote will not be able to access the file unless you update the field with the new link.
<table>
<thead>
<tr>
<th>File Attachments</th>
<th>Author Address</th>
</tr>
</thead>
</table>

Similarly we can add the **word file** as well; unfortunately Endnote will not display the word file from its window as seen right above.
6. Print or save a list of references

**Printing selected references**

The printed or saved format is controlled by the current bibliographic output style

Selecting references for printing

1. Select a Group, then Reference

2. From the Reference Menu, Click on *Show Selected References*

The Selected references will be only visible as below
The Print or Preview will be as follows,


Saving (export) selected references
Continued with earlier selection

1. Select Reference/s for export
2. Click on export icon
3. Write a filename
4. Select an output style: say Annotated
Select Tab Delimited output style To copy the data to excel

Select filetype as text-file
7. Insert citations into the word document
Make sure the relevant EndNote library holding necessary references is open.

Inserting citations from word document itself
Using the Insert Citation command in Word
Move the cursor to the required position for the citation in your document.

From the EndNote ribbon Citations group, expand Insert Citation and click on Insert Citation...

1. Click on EndNote X7 ribbon
2. Place cursor at required place
3. Click on insert citation icon

The following search box will appear
3. Type a term in the box and click on **Find**. Then

4. Select the correct reference from the list

5. Click on **insert**

5. Click and Hold: The following options are also available to insert the reference(s) in the text:

- **Insert & Display as: Author (Year)** – this will display the author’s name outside the parentheses
- **Insert & Exclude Author** – the author will not appear if you are using an Author-Date output style
- **Insert & Exclude Year** – the year will not appear if you are using an Author-Date output style
- **Insert in Bibliography Only** – a citation will not appear within the text, but the reference will appear in the bibliography

**Contribution of researches in the fields of Science to the Webometric ranking of research institutions of Sri Lanka: A Study on Scopus and Web of Science**

1. Introduction

Webometric ranking of a research institution relay on the web-visibility of the institution; which mainly assesses the research works of affiliated universities and its impact in the international scholarly communication through web. The first ranked university of Sri Lanka is ranked above 2000 in the international ranking order. ([Aguillo, Bar-Ilan et al. 2010])
At the end of the document:


**Inserting citations from EndNote**

1. Place cursor at required place
2. Click on *Go to EndNote*
3. Select a Group, which may hold interested reference
4. Search interested reference
5. From search result, select reference/s to be inserted
6. Click on *Insert Citation*

A Review of Literature

Rozman and Mathl's (2008) paper presents the results of a case study of the University of Maribor. They emphasize that ranking of heterogeneous young universities without established reputations must be conducted very carefully. Usually, such universities do not appear in lists of the top universities in the world. This should not be understood as a problem, but as an opportunity for development. Global university rankings can strongly influence the self-efficacy of the university. Our results show that more successful institutions are less affected by global competition between institutions. The results indicate that competition between institutions emerges, representing an important driving force in acquiring further development and achieving higher status. The results present an example of good practice.
A Review of Literature

1. Rozman, I. and M. Marhl (2008)’s paper presents the results of a case study of the University of Maribor. They emphasize that ranking of heterogeneous young universities without established reputations must be conducted very carefully. Usually, such universities do not appear in lists of the top universities in the world. This should not be understood as a problem, but as an opportunity for development: global university rankings can strongly contribute to university development. Our results show that more successful institutions can have a stimulating effect on the less successful ones. A healthy competition between institutions emerges, representing an important driving force in assuring further development and achieving higher status. The results present an example of good practice(Rozman & Marhl, 2008)


If we are not sure that the cursor is in the correct position in your document do not use the Insert Citation button. Instead:
1. From the EndNote toolbar select Go To Word Processor.
2. Move the cursor to the required position for the citation in your document.
3. From the EndNote ribbon Citations group, expand Insert Citation and click on Insert Selected Citation(s).
8. Generate bibliography in different style

**Output style**
The output style controls the appearance of citations in the text and references in the bibliography, including:

- text attributes, e.g. bold, underline, italic, capitalisation.
- author name format, number of authors before ‘et al’.
- fields appearing in the bibliography for each reference.

1. To select an output style, use the drop-down list in the EndNote ribbon of a MS Word Document.

1. Alternatively, click on the arrow icon in the bottom right corner to display the Configure Bibliography window and choose an output style:

EndNote comes with many available styles, to search for one that matches your desired format:
Go to EndNote

The following option will be available.

Additional styles can be downloaded from the EndNote support website, click on *Get More on the Web* to access these.

**Layout**

The Layout tab (in the Configure Bibliography window) controls the appearance of the bibliography
Appendix I:

Citation Download Methods from the Databases subscribed for University of Jaffna

1. Sage

1. Click on
2. Select Title
3. Write Keyword(/s)
4. Click on
5. Select the Bibliography Style (Can be altered in EndNote)
6. Select a bibliography description standard
2. Emerald

1. Click on

2. Write Keyword (/s)

2. Select content item Title

2. Click on

3. Click on Search
4. Click on

5. Choose metadata format “Endnote”

6. Uncheck it for view from browser

7. Click on

1. Click on

2. Click on
4. Oxford Journals

1. Click on

2. Write down a Keyword

3. Click on

4. Select

5. Check on

6. Click on “Go”
5. Chicago Journals

1. Click on "Advanced Search"

2. Write Keyword (/s) "Banking AND Finance"

3. Click on "Search"
Finance, Figuration, and the Alternative Banking Group of Occupy Wall Street

Hannah Appel

Signs, Vol. 40, No. 1 (Autumn 2014), pp. 53-58

...of capitalism. But attention to figuration can also expand the fields of possibility, allowing us to reimagine both pasts and futures (Haraway 1997). Below, I follow Tsing and Donna Haraway to think through finance and figuration with the Alternative Banking Group of Occupy Wall Street.1 Attention to Alt Banking participants allows...

Export Citations

To export a citation, choose one of the formats listed below.

Select a format:
- RIS file (EndNote, ProCite, Reference Manager)
- Text file (BibTex) Opens in a new window. Select "Save As" on the file menu, and save as text file.
- Printer-friendly
- RefWorks

6. ARDI

(Username & Password Available)
FINANCE AS A BARRIER TO ENTRY: BANK COMPETITION AND INDUSTRY STRUCTURE IN LOCAL U.S. MARKETS

by Nicola Cetorelli, Philip E. Strahan, Franklin Allen, Richard J. Herrig, Nicola Cetorelli, Philip E. Strahan, 2003

"... the problems and opportunities facing the financial services industry in its search for competitive excellence. The Center's research focuses on the issues related to managing risk at the firm level as well as ways to improve productivity and performance. The Center fosters the development of a ..."

Abstract: Cited by 46 (3 self) - Add to MetaCart


by Nicola Cetorelli, Philip E. Strahan, Franklin Allen, Richard J. Herrig, Nicola Cetorelli, Philip E. Strahan

Citations: 66 - 3 self
7. ASABE

American Society of Agricultural and Biological Engineers
8. American Institute of Physics

![American Institute of Physics logo]

**Advanced Search**

Enter one or more search criteria below. Boolean AND, OR and NOT are supported (e.g. higgs AND boson). Use quotation marks to find an exact phrase (e.g. "baryon decay"). Use asterisks to match partial words in fields (e.g. neutron*).

![Search form with 'Current Voltage Characteristics' filled in]

**PUBLICATION RESULTS**

Thickness dependence of the poling and current-voltage characteristics of paint films made up of lead zirconate titanate ceramic powder and epoxy resin
Shigenori Egusa and Naozumi Wasawa
J. Appl. Phys. 78, 6060 (1995); [http://dx.doi.org/10.1063/1.360546](http://dx.doi.org/10.1063/1.360546)

+ View Description

[Download PDF] [Add to my favorites] [Export citation]

- BibTeX
- EndNote
- Plain text
- ReFWorks